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5.8. Intersite Transfers Planning

Streamline is able to optimize your inventory by releasing frozen capital internally, and replenish your
locations using your own overstocks instead of making any more replenishment orders from your
suppliers or distribution centers.

If your business is spread out over several separate regions so that each of them contains a set of
locations where inventory transfers are allowed, Streamline can account for these constraints and
generate transfers within the given areas.

In this article you will learn:

* How to enable intersite optimization feature.

e How Streamline generates intersite transfers and the delivery date for a transfer in particular.
e How to apply transfer region constraint.

e How to export prepared transfers into Excel or your database.

To demonstrate all of these, we use a little project based on a database source. We have only two
products here, t-shirt and dress that are sold in three stores, east, north and west (see figure
below).

@ start |24 Demand forecasting % Inventary planning (&l Reports lgll Dashboard
SF Mew filter | All items

Search | “% *ﬁSEtﬁngs B8 In transition details @Expurt table - %Expnrt parameters ¥ Import paramete
ltern code  Location  Onhand  To receive Lea;l time, urrent erder Next order Stockout Overstock
ays Oty  Value Delivery date date

idress | east 800 626 0 0 Oct 24, 2019 0 258

2 II|FE ................. north 200 123 390  TBO00  Oct24 2019 Sep 11,2019 190 1]

3 dress west 500 4 119 29730 Oct24 2019 Sep11,2019 0O 0

4 t-shirt east 500 200 0 0 Oct 24, 2019 0 100

5 t-shirt north 500 0 0 0 Oct 24, 2019 0 500

& t-shirt west 200 156 438 43800 Oct24, 2019 Sep 11,2019 83 1]

There are overstocks for three planning items, and, at the same time, two items have stockouts. Let's
see, if Streamline can restock required quantities using intersite transfers. By default, intersite
optimization feature is disabled. Let's enable it.

Enabling Intersite Optimization

To enable intersite optimization:

1. Go to the menu File > Settings.

2. Navigate to the Project tab of the Settings dialog.

3. Check the option Enable intersite optimization under the Inventory planning group (see
figure below).
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Settings X

General Project ABC analysis Inventory Distribution center Das ¥ |k

Update data
] Quick update (no history overlap)

Forecast

Model is seasonal when test =

[] Forecast prices separately from demand

Inventory planning

Enable inter-store optimization

Default inter-store lead time days

] Enable ordering availability

Combine Display gty with Safety stock as:
(®) Maximum ) Sum

Inventory carrying costs

Annual interest rate (reduces margin) %h

Reports
[] add quantity-to-receive to on-hand for KPI calculations
(Impacts the calculation of stockouts and days of supply)
Supply tme in (@) Days () Months
Measure of forecast quality (@ MAPE () Accuracy = 100% — MAPE

Cancel

There is also a control for setting the default lead time for a transfer, in case the destination location
is not supplied from a DC normally - Default intersite lead time. By default, it is 1 day.

After we click OK, a new column Available for transfer has been added into the Inventory
planning tab, and a new tab called Intersite optimization has been added into the set of
application tabs (see figure below).
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@ Start @ Demand forecasting Inventory planning i Inter-store optimization == Reports Hﬂﬂ Dashboard
L‘f' Mew filter | All items

Search | “% 'ﬁSEtﬁngs WHRIn transition details Expu:urt table - %Expurt parameters @Impurt parametel

ltem code  Location  On hand To receive Lea;l:l time, cunentorder Stockout Cwerstock Available for
ay's Oty  Value Delivery date transfer

1 idress | east 800 626 0 0 Oct24,2019 0 258 258

2 dress ................... nerth 200 123 390 73,000 Oct24, 2019 190 0 0

3 dress west 500 4 119 29750 Oct24,2019 0 0 0

4 t-shirt east 500 200 0 0 Oct24 2019 0 100 100

5 t-shirt nerth 500 0 0 0 Oct24, 2019 |0 500 500

& t-shirt west 200 156 433 43,800 Oct24, 2019 83 0 0

The Available for transfer column shows an overstock quantity that can be used to replenish other
locations through intersite transfers. It indicates the minimal expected overstock amount during the
Lead time (in our case, 30 days).

As you see from the figure below, the available quantity is enough to cover both stockouts.

'a Start El Demand forecasting Inventory planning E Inter-store optimization E= Reparts uﬂﬁ, Dashboard
\f' Mew filter | All items

Search | 4 'ﬁSEtﬁngs @M In transition details Expu:urt table - %Expurt parameters @Impurt paramet
ltern code  Location  Onhand To receive Lealjl time, cunent erder Stockout Owverstock Available for
ay= Oty  Value Delivery date transfer

1 dress east 800 626 0 0 Oct 24,2019 0 258
2 dresz north 200 123 390  T7R000 Oct24, 2019 |190 0 0

3 dress west 500 54 119 29730 Oct24, 2019 |0 0 0

4 t-shirt east 500 200 0 0 Oct24 2019 0 100 100

5 t-shirt north 500 0 0 0 Oct24 2019 0 500 500

& t-shirt west 200 156 433 43,800 Oct24, 2019 ] ]

Let's proceed to the Intersite optimization tab and see the suggested transfers (see figure below).

@ Start ] pemand forecasting Inventory planning 'f;.’ Inter-store optimization [ Reports lgll pashboard
HF Mew filter | All items

Search |'-‘§ dgksettings  WMPIn transion details [ Export table  + RgExportparameters  JEImport parameters ¥ 4|

R

Lead time, Order cycle, Current order

ltern code  Location On hand To receive
days months Oty

Value  Ordertype  Sourcefrom  Delivery date

1 Edress north 200 123 190 38,000  Transfer east Sep 25, 2019

2 t-shirt west 200 156 a3 2,300  Transfer north Sep 25, 2019

We have two transfers here, each covers the required stockout at a particular location completely.
Streamline uses a special method to generate intersite transfers. The quantity to transfer not always
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equals to the Stockout amount. It is found as a minimum between replenishment quantity
recalculated for the Default intersite lead time (or lead time from DC) and Stockout. In our
example, the minimum drop to the Stockout for both transfers. Let's check this out.

To do this, we go to the Inventory planning tab and set Lead time to 1 day for items with
stockouts (see figure below).

"qipi' Start [5| Demand forecasting % Inventary planning : Inter-store optimization =] Repor
S Mew filter | Allitems

.....

Search G, SFscettings YM§In transition details [ |Export table %Expnrt parame

Fat

Lead time, Crder cycle, Current order

ltem code  Location  On hand  To receive d h ]
ay= menths Oty Value Delivery date

1 dress east 200 026 0 0 Oct 24, 2019
2 dress north 200 123 1 203 |40,600 Sep 25, 2019
3 dress west 500 54 119 29750 Oct 24 2019
4 t-shirt east 500 200 0 ] Oct 24, 2019
5 t-shirt north 500 0 0 0 Oct 24, 2019
& t-shirt west 200 156 1 248 124,800 Sep 25, 2019

As you see, suggested quantities 203 and 248 are bigger than the corresponding stockouts 190 and
83.

Note: If the Stockout amount is less than Net Order, then Streamline will suggest transfering exactly
the Stockout amount. No rounding, min lot or max lot will be taken into account.

Now, let's explain how Streamline calculates the delivery date for transfer orders.

Transfer Order Delivery Date Calculation

Streamline determines the delivery date for a transfer following the logic:

e If the destination location is not tied to a DC, Streamline considers the transfer to arrive after
the Default intersite lead time. For example, if the current date is Sep 2, 2018, and the
Default intersite lead time is 1 day (which is the default value), then Streamline determines
the delivery date as Sep 3, 2018.

« If the destination location is normally supplied from a DC, it is calculated as:

Delivery date = Today date + Lead time,

where:

* Lead time - the interval of time required to deliver the item from the distribution center to the
destination location.
e Today date - the current local date set in your operating system.
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Let's demonstrate both situations.

Our example doesn't have a distribution center configured, it contains stores only. The today date is
Sep 25, 2019, thus, Streamline determines the delivery date as Sep 26, 2019 and shows it in the
Delivery date column (see figure below).

@ Start @ Demand forecasting @3 Inventory planning : Inter-store optimization E= Reports Hﬁﬂ Dashbc
P MNew filter | All items

SEErc |""\_\, @Setﬁngs M3 In transition details @Expurt table - %Expurt parameters {Elmpnn

: Current order
ltern code  Location On hand To receive Lea;l time, ]
ay's Oty Value  Ordertype  Source from | Delivery date

1 dress north 200 123 190 33,000  Transfer east Sep 26, 2019

2 t-shirt west 200 156 a3 3,300 Transfer north Sep 26, 2019

To illustrate the second case, we enabled distribution center and configured it to incorporate the east
location. The Lead time is 30 days. Now, the delivery date is Oct 25, 2019 (see figure below).

@ Demand forecasting @ Inventory planning : Inter-store optimization liﬂ Distribution center

All items

Q) start

S New filter

|'-Q, ﬁSEtﬁngs B In transition details @Expurttﬂble hd %Expnrtparamet&rs @Impc

Lead time, Current order

days

ltermn code Location On hand To receive
Cty  Value Source from | Delivery date
200 156 a3 8,300 Oct 25, 2019

Delivery date is a Streamline's promised date the item to be received on. Of course, you can modify
or reset it in your system after the transfer orders have been exported in there.

Order type

Transfer north

Now, let us show how to introduce region constraint in the optimization.

Applying Transfer Region Constraint

To be able Streamline to put region constraint on the generated transfers, the Transfer region data
type should be configured and imported along with other information about your inventory. To do this,
we will reconfigure our connection setting to the
database:http://direct.gmdhsoftware.com/documentation-sl/lib/images/toolbar/image.png

1. Go to the menu File > Change connection > Database connection.

2. Navigate to the Item info tab, click the Preview button to execute our query. This query
returns a table containing descriptive information for each planning item. The last column of the
table contains the transfer region (see figure below).
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Database connection O ot
ODBC  » | Data source name |ver};Server=server-pc;DataI:uase=sI—testj V| Build... Tables Read
User name | Password | Protection... InTransition
iterninfo
Transactions Item info Orders to receive Orders to ship Substitutions 1* | pPOHeader
POLine

select * from itemInfo .
trace_xe_action_map

trace_xe_event_map
transactions

Use drag-and-drop to copy table and column names.

Group timestamps by |Month  * |starting from [] combine locations

Preview Export to CSV [] update data only Save Cancel
last_on_hand price supplier location item_code model_from transfer_region | ™
Last on hand Purchase pricef... Supplier code Location ltem code hd -
1 500 50 2-311 gast t-shirt dress virginia
2 200 100 2-311 west t-shirt dress virginia
3 500 250 4-555 west dress dress virginia
4 300 200 4-355 gast dress dress virginia v

3. Now we match this column to the Transfer region meaning selected from the dropdown (see
figure below).
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Database connection

ODBC  » | Data source name |ver};Server=server-pc;DataI:uase=sI—testj V| Build...

User name | Password | Protection...
Transactions Item info Orders to receive Orders to ship Substitutions |»
select * from itemInfo

Prewview

last_on_hand
Last on hand
1 500
2 200
3 500
4 500

Purchase pricef... Supplier code

50

100
250
200

Export to CSV

price

2-311
2-311
4-555
4-355

supplier

location item_code model_from
Location [tem code
east t-shirt dress
west t-shirt dress
west dress dress
east dress dress

Group timestamps by |Month  * |starting from [] combine locations

[] update data only

Location descriitiun
]

Location category

Tables Last on hand
InTransition Q't}‘:':' 5h'F'_
iteminfa Qt}r o receive
POHead Delivery date

\eader Use model from
POLine Lead time
trace_xe_action_map Lead time variance
trace_xe_event_map Order cycle
transactions Rounding

Min lot
Max lot

Supplier code
Supplier's itern code
Supplier's currency
Supplier's min. weight
Supplier's min. velum
Supplier's min. gty
Supplier's min. cost
Shelf life, periods
Shelf life, days
Weight/unit

Use drag-and-drop to copy t2 Volume/unit

Sales price/unit
Purchase price/unit
Inventory value/unit
# of pericds for safety
DC name

Display gty

Service level

Info field

I

virginia

virginia

virginia

virginia

4. To import the column, we click OK.

After application the transfer region constraint, the transfer of 190 units for dress has disappeared
(see figure below).

) start

Demand forecasting

Lf' Mew filter | All items
Search

ltem code  Location  Transfer region
1 ét-shirt | west virginia

@ Inventory planning

On hand To receive

200

days

h|

156

Lead time,

E Inter-store optimization

a3

E| Reports

ﬁﬂﬂ Dashboa

| “% ﬁSEtﬁngs W5 In transition details Expu:urt table - %Expnrt parameters @Impurtp

Current order

Cty  Value Scurcefrom  Delivery date

8,300 east

Sep 25, 2019

That has happened because the location with the overstock is located in a different region (see figure

below).
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'a Start |;| Demand forecasting @ Inventory planning E Inter-store optimization = Reports Hﬂﬁ Dashboard
\f‘ Mew filker | all items

Search | “% @Setﬁngs W45 In transition details Export table - %Export parameters @Import parameters ¥ | Planned ¢

Itern code  Location  Transfer region  On hand  To receive Leaéjaii;ne, Current curdelr Stockout Owerstock AV;!?EL‘:N
City Value Delivery date

1[dress  ieast virginia |eoo 626 0 0 Oct24,2019 0 258 258

2 dress north california 200 123 390 7000 Oct24, 2019 190 ] 0

3 dress west virginia 500 54 119 20750 |Oct24, 2019 0 0 0

4 t-shirt east wvirginia 500 200 0 0 Oct24, 2019 0 100 100

5 t-shirt north california 500 0 0 0 Oct24, 2019 0 500 500

6 t-shirt west virginia 200 156 438 43,800 | Oct24, 2019 83 ] 0

Exporting Intersite Transfer Orders

To export intersite transfer orders:

1. Go to the Intersite optimization tab.
2. Click the Planned orders button found on the toolbar. The Planned orders preview dialog
appears (see figure below).

Planned orders preview | X

e

Supplier ltem code Description Location City Ordertype  Source from  Value Order#  Delivery date Mext order

date
1 2-311 t-shirt west 83 Transfer north 2300 1 Sep 26, 2019 Sep 11, 2019

2 4-535 dress nerth 190 Transfer east 32000 2 Sep 26, 2019 Sep 11, 2019

[] remove future arders from the list
Order items with stockout ignoring ™ext order date

[] indude manufacturing orders

Export to XLSX | Export to CSV| Total cost 46,300. Cancel

There are several exporting options:

e Export to XLSX button exports the orders to an Excel file.

e Export to CSV button exports them to a CSV file that can also be opened in Excel. Typically,
this option is used to export huge orders.

¢ Create button exports orders to the database.

3. We click the Create button to export our orders right to the database.

& Planned orders ot

o Orders successfully created.
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As soon as orders have been exported, Streamline:

e clears the exported lines from the Intersite optimization tab; and
¢ adds the corresponding transactions into the To receive list of the In transition details
dialog.

Let's check this. We click the In transition details button found on the toolbar to open the In
transition details dialog (see figure below).

In transition details O x
Sea =Y
To receive To ship
Delivery date  Itern code Description  Location Oty Ordertype  Scurcefrom  Sendout date  Supplier Cost Order number
1 éxSep 26, 2019 dress north 190 Transfer east Sep 25, 2019 4-5355 Export
2 zSepZE,ED'IE' t-shirt west a3 Transfer north Sep 25, 2019 2-311 Export
3 Juldl, 2019 dress east 110 DC 4-555
4 Jul 23, 2019 dress east 50 DC 4-5535
5 Jul 24, 2019 dress east 133 DC 4-555
6 Jul 26, 2019 dress east 333 Manufacture DC 4-5535
7 Jul22 2019 dress north 123 DC 4-555
g Jul2g, 2019 dress west 54 Transfer DC 4-5535
g  Jul 30, 2019 t-shirt east 200 Manufacture DC 2-311
10 Jul 28, 2019 t-shirt west 156 DC 2-311
Export to XLSX Close

Now, along with other orders which are to be received, Streamline shows the just now exported
orders. These orders got an Export mark in the Order number column.

Lines with the Export mark have no common with the real orders-to-receive that are in your ERP's
database. It's just internal Streamline's transactions that are created in order to keep the inventory
planning workflow correct.

If Streamline is integrated with your system so that clicking the Create button automatically creates
the corresponding open orders, the mark Export will disappear for the exported lines in the To
receive tab after you click the Update data button. Otherwise, the Update data command will
completely remove the exported lines from the To receive tab.

Next: Material Requirements Planning
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